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Установка 
 
Для установки программы Установщик вставьте компакт-диск в привод CD-ROM компьютера. 
Автоматически запустится программа установки, и на дисплее откроется показанное ниже окно. 
Если окно не откроется, откройте Проводник и найдите на компакт-диске программу с названием 
'Setup'. Запустите эту программу, и вы увидите показанное ниже окно. 
 
 
Второе диалоговое окно спросит, в какое место папки 'Program Files' следует установить 
программу Установщика. Как правило, это окно можно сразу пропустить. 
 
 
Затем будет предложено выбрать группу меню Пуск. Если вы хотите поместить программу в уже 
существующую группу, выберите ее в предложенном списке. Как правило, это окно можно 
пропустить и сразу же нажать кнопку “Continue” (Далее): 

 
 
По завершении установки откроется следующее диалоговое окно: 
 
Оно означает завершение процесса установки. 
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Запуск программы 
 

Для запуска Установщика откройте меню Пуск, найдите программную группу, в которую был 
установлен Установщик (по умолчанию 'Panel Installer'), и дважды щелкните на значке программы: 
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Что такое точка? 
 
Точкой называется группа пожарных станций/панелей аварийного освещения, относящихся к 
одному производственному помещению. При сохранении или извлечении информации о точке 
программа Установщика обращается к базе данных точки. 
 
Информация о точке включает следующие сведения: 
 
 1) Название компании и место расположения точки. 
 2) Подробное описание Пожарных станций/Панелей аварийного освещения. 
 
Когда создание точки завершено, пусконаладка каждой пожарной станции осуществляется в 
соответствии с информацией, сохраненной в базе данных. База данных хранится в виде записи, 
поэтому если конфигурация точки в будущем изменяется, есть возможность извлечь и изменить 
старую конфигурацию этой точки. 
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Создание точки 
 
Чтобы создать точку, щелкните на пункте меню File>New Site (Файл > Создать точку). Откроется 
диалоговое окно с вопросом, где вы хотите создать новую точку, и как вы хотите ее назвать. 

 
 
После того, как вы введете имя точки и нажмете кнопку 'Open' (открыть), откроется форма с 
информацией о новой точке. На этом этапе, все незаполненные поля содержат текст 'None' (нет). 
 
 
После заполнения формы и нажатия кнопки 'OK', создается новая точка. 
 
Процесс создания новой точки можно отменить, щелкнув на кнопке 'Cancel' (отмена) в диалоговом 
окне открытия точки или в окне с подробной информацией о точке. 
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Загрузка точки 
 
Чтобы загрузить точку, щелкните на пункте меню File>Load Site (Файл > Загрузить точку). 
Откроется диалоговое окно 'Load Database' (загрузка базы данных): 
 
 
Чтобы загрузить точку, дважды щелкните на файле, который хотите открыть, или щелкните на 
файле один раз, а затем щелкните на кнопке 'Open' (открыть). 
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Перемещение по точке 

 
После загрузки точки в программу Установщика, можно просматривать относящуюся к ней 
информацию, представленную в виде дерева 'Site Overview' (обзор точки). 
 
 
Дерево обзора представляет информацию о точке в виде иерархической структуры, содержащей 
Станции, Шлейфы и Зоны. Верхний узел дерева представляет саму точку. Для перемещения по 
дереву надо щелкнуть на значке «свернуть/развернуть», а затем щелкнуть на том уровне, который 
вы хотите увидеть. Интерфейс изменяет свой вид так, что становится видна информация о точке, 
в зависимости от того, на каком уровне дерева вы щелкнули. 
 

Уровень точки 
 
При выборе самого верхнего уровня, открывается окно 'Site Details' (информация о точке): 
 

Уровень станции 
 
Если выбрана станция, открывается окно 'Panel Details' (информация о станции). Вид окна 
изменяется в зависимости от типа выбранной станции: 
 

Уровень шлейфа 
 
При выборе шлейфа, открывается окно 'Loop Details' (информация о шлейфе). В нем 
отображается полный набор устройств шлейфа. На этом уровне зоны/группы не различаются: 
 
Уровень зоны/группы 
 
При выборе зоны/группы, открывается окно 'Zone/group Details' (информация о зоне/группе), в 
которой отображаются устройства, относящиеся к данной зоне/группе. Устройства, относящиеся к 
другим зонам, выделяются серым цветом: 
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Добавление и удаление станции 

 
Добавление станции к точке 
Для добавления станции, щелкните в дереве обзора на кнопке 'Add Panel' (добавить станцию). 
Отроется окно 'Add New Panel' (добавление новой станции): 
 

 
Типы станций, которые можно добавить к данной точке, выбираются из выпадающего списка. 
Откройте список, щелкнув на стрелке, расположенной справа от поля ввода, и выберите нужный 
тип станции. Выбранный тип должен появиться в текстовом поле 'Panel Type' (тип станции). Если 
станция должна подключаться к сети, отметьте поле 'Networked' (подключение к сети) и выберите 
адрес в списке имеющихся адресов: 
 
 
Примечание: Если адрес не выбран, станции присваивается нулевой адрес (Адрес 0). 
 
Щелкнув на 'OK', добавьте станцию к точке. Щелкнув на 'Cancel' (отмена), можно отменить 
добавление новой станции. 
 
Удаление станций из состава точки 
Для удаления станции из состава точки, выберите в дереве обзора станцию, которую надо 
удалить, и щелкните на кнопке 'Delete Panel' (удалить станцию). Появится следующее сообщение: 
 
 
Цель этого окна – предотвратить случайное удаление. 
Эта операция необратима. Будьте осторожны и обращайте внимание на то, что удаляете! 
 
Отменить процесс удаления можно, щелкнув на кнопке 'No' (нет). При этом станция останется в 
составе точки. 



 10

Редактор текста 
 
Редактор текста используется для ввода в устройство текстовой информации. Текстовый редактор 
расположен в основном меню 'Device Manger->Text Manager' (Диспетчер устройств – Текстовый 
редактор). Это меню становится активным только при выделении шлейфа в дереве обзора точки. 
Если меню выделено серым, оно не активно, если черным - активно: 
 
Щелкните на пункте меню, и откроется интерфейс текстового редактора. В нем отображается 
таблица устройств, отсортированных по зонам, и в пределах зоны – по адресу. 
 
Редактор текста предназначен для быстрого ввода текста в устройства. Чтобы начать ввод, 
щелкните на строке с устройством, для которого хотите изменить текст. Текущий текст появится в 
текстовом окне в нижней части экрана. Отобразится также адрес устройства и его тип: 
 
Для изменения текста просто напечатайте новый текст и нажмите на клавиатуре клавишу 
перевода строки (enter). Таблица покажет внесенные изменения, и в окне текста устройства (в 
нижней части экрана) появятся данные, соответствующие следующей строке таблицы. 
 
После внесения всех необходимых изменений, их надо применить к базе данных. Для этого нужно 
щелкнуть на кнопке 'Apply Changes' (применить изменения). Если выйти из редактора текста, не 
щелкнув на кнопке 'Apply Changes', вся введенная информация потеряется. 
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Распечатка отчета 

Выберите пункт меню File -> Reports (Файл -> Отчеты). Откроется диалоговое окно выбора отчета. 
 

 
 
Отчеты о программировании устройств создаются в формате HTML и по умолчанию отображаются 
в программе Internet Explorer. Имеется пять разных типов отчета: 
 
Отчет о точке 
Отчет обо всех устройствах всех станций точки 
 
Отчет о станции 
Отчет об устройствах данной станции данной точки 
 
Отчет о шлейфе 
Отчет об устройствах данного шлейфа данной станции 
 
Отчет о зоне 
Отчет об устройствах данной зоны данной станции 
 
Отчет об устройстве 
Отчет обо всех устройствах конкретного типа на данной станции 
 
Чтобы пункт меню Reports (отчеты) стал доступен для вновь созданного сайта, выберите станцию 
в дереве обзора. 
 
При выборе отчета о зоне, выпадающий список зон сортируется в алфавитном порядке, который 
может не совпадать с порядком отображения зон в дереве обзора. 
 
Столбец с заголовком 'Output' (выход) содержит номер выхода и номер каскада, разделенные 
косой чертой. 
 
ПРИМЕЧАНИЕ: 
В программе Internet Explorer версии 6.0 имеется известная ошибка, из-за которой правая сторона 
страницы может отображаться неправильно, в результате чего в распечатке больших отчетов 
могут отсутствовать некоторые столбцы. Для устранения этой проблемы сделана специальная 
надстройка для Internet Explorer, которую можно загрузить здесь 
 
Загрузка программы печати для IE 
 
Инструкции по установке можно взять здесь 
 
Инструкции по установке 
 

После установки этой надстройки, на панели инструментов появится новый значок:  
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Этот значок позволяет распечатать страницу с правильными полями. Если щелкнуть на значке, 
удерживая CTRL, откроется окно предварительного просмотра. 
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Изменение коммуникационного порта 
 

По умолчанию Установщик точки использует коммуникационный порт COM1. В некоторых 
ситуациях COM1 может оказаться недоступным. В этом случае выберите пункт меню View -> Com 
Port Settiings (Вид -> Настройка порта). Откроется следующее окно: 
 
Все коммуникационные порты компьютера отображаются в виде выпадающего списка. Выберите 
нужный порт и щелкните на OK. 
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Общая информация о станции DF6000 
 

Введение 
Станции DF6000 обеспечивают все необходимые функции, присущие самым передовым адресным 
аналоговым станциям, и в то же время очень просты в эксплуатации и установке, что по 
достоинству оценят и монтажники, и владельцы зданий. 
 
Станция может монтироваться заподлицо или на поверхности стены, а металлический корпус 
приличного размера предоставляет удобные средства для бокового или заднего ввода кабелей. 
Станция выпускается в виде версий для одного, двух или четырех шлейфов, со встроенным 
принтером и без него. 
Кроме того, выпускаются пассивные станции и станции с полнофункциональным ретранслятором. 
 
Станции DF6000 могут работать в автономном режиме или в составе многостанционной сети. 
 
Для DF6000 выпускается широкий диапазон вспомогательных устройств, включая оптические, 
ионизационные, фототермические и тепловые извещатели, устанавливаемые в основание и 
автономные звуковые сигнальные устройства (включая версию IP67), световые извещатели с 
питанием от шлейфа и широкий диапазон входных и выходных интерфейсов. 
 

Интегрированная конструкция системы 
Каждый системный компонент DF6000 специально выполнен так, чтобы работать в составе 
системы DF6000. Это гарантирует полную взаимную совместимость станций, извещателей и 
интерфейсов, и полную поддержку всех функций системы каждым устройством. 
 

Хорошо продуманные функции управления звуковыми 
сигнальными устройствами 
Пожарная станция DF6000 обладает высокой гибкостью и широким набором функций, 
спроектированная так, чтобы ее можно было применять в самых разных конфигурациях. 
Помимо большого ЖК-дисплея, отображающего полную информацию о состоянии системы, 
станция имеет 96 традиционных зонных индикаторов, предоставляющих четкую информацию о 
состоянии и распространении пожара, в которой легко разберется даже человек, совершенно не 
знакомый с работой системы. А число индикаторов состояния системы рассчитано так, что 
состояние системы хорошо понятно даже человеку без специальной технической подготовки. 
 
DF6000 способна удовлетворить самые сложные требования к характеру звуковой сигнализации. 
Возможно многокаскадное программирование причин и действий, причем каждое адресуемое 
звуковое сигнальное устройство или выходной интерфейс могут программироваться независимо 
друг от друга, и могут быть настроены так, чтобы реагировать на конкретные адреса, конкретные 
зоны, конкретные станции или просто работать как стандартные глобальные звуковые 
извещатели. 
 
Станция DF6000 поддерживает три независимых набора программ звукового оповещения, и 
каждый каскад может запускаться независимо от других. 
Например, если сработал некоторый отдельный извещатель, станцию можно запрограммировать 
так, чтобы ближайшее к нему звуковое сигнальное устройство включилось немедленно и в 
непрерывном режиме, остальные звуковые сигнальные устройства в этой зоне работали бы в 
импульсном режиме, а все другие звуковые сигнальные устройства включались бы с задержкой на 
установленное время, чтобы можно было определить причину срабатывания до включения общей 
звуковой сигнализации. 
 
В каждом каскаде, звучание каждого звукового сигнального устройства можно запрограммировать 
на непрерывный режим, импульсный режим или срабатывание с задержкой. 
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Простой интерфейс пользователя 
Основным элементом интерфейса пользователя является большой сенсорный экран (с видимой 
областью 120 мм x 90 мм), который предоставляет полную информацию и используется в качестве 
многофункциональной клавиатуры. 
При работе с другими, более простыми системами, пользователь ограничен небольшим числом 
жестко назначенных кнопок, что сильно ограничивает и усложняет управление системой. 
 
Сенсорный экран станции DF6000 автоматически перестраивается в соответствии с текущей 
функцией. Например, если выбрать в меню функцию изменения текста устройства, экран 
автоматически превратиться в полную QWERTY клавиатуру, позволяя быстро и легко вводить 
текст. 
 
Применение сенсорного экрана позволило встроить в станцию целый ряд разнообразных 
пользовательских и инженерных функций, сохранив при этом простоту управления. 
Можно, например, добавлять и удалять устройства или изменять текст устройства, не вызывая для 
этого инженера по обслуживанию. 
 
Полнофункциональный сенсорный экран дополняется традиционными светодиодными 
индикаторами, включая 96 зонных индикаторов. 
 
Хотя станция DF6000 обладает расширенным набором функций, позволяющим настраивать 
систему прямо на месте, максимальную гибкость обеспечивают функции загрузки и выгрузки 
конфигурации, которые обеспечивают быстрое и простое программирование всех функций точки. 
Для всех меню предусмотрена контекстная справка, которая помогает тем, кто не знаком с 
работой системы. 
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Добавление зон к шлейфу 
 
Перед помещением устройства на шлейф, нужно определить зону, в которую будет помещаться 
это устройство. Зоны показаны на приведенном ниже дереве обзора и обозначаются именами от 
'Зона 1' до 'Зона 250'. 
 
Для добавления новой зоны, надо выбрать шлейф на дереве обзора. Выбор шлейфа активизирует 
кнопку 'New Zone' (создать зону). Щелкните на кнопке 'New Zone', и откроется диалоговое окно New 
Zone (создание зоны). Все доступные номера зон представлены списком в нижней части окна, и 
для добавления новой зоны нужно выбрать один из этих номеров. Чтобы добавить зону, щелкните 
на кнопке 'OK' в нижней части окна. 
 
Новая зона появится в дереве обзора, и к ней можно будет добавлять устройства. 
 
Для отмены добавления новой зоны, щелкните на кнопке 'Cancel' (отмена) в окне добавления 
зоны. 
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Удаление зон из шлейфа 
 
Для удаления зоны из шлейфа, выберите на дереве обзора зону, которую нужно удалить. Для 
удаления зоны, щелкните на кнопке 'Delete Zone' (удалить зону). Зона удалится из древа обзора 
точки, при этом вся информация о зоне и устройствах из шлейфа также удалится. 
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Добавление устройств к шлейфу 

 
Примечание: Устройство можно добавить к шлейфу лишь в том случае, если сначала была 
создана зона, в которой должно находиться это устройство. 
 
Для добавления устройства к шлейфу выберите в дереве обзора зону. Выбранная зона должна 
быть той зоной, в которую нужно поместить устройство. 
 

 
 
Вторым шагом будет выбор типа добавляемого устройства. Тип устройства выбирается из 
выпадающего меню в окне Device Control (управление устройством). Окно управления устройством 
расположено в левой нижней части интерфейса. 

 
 
Чтобы открыть список, щелкните на направленной вниз стрелке справа от комбинированного поля 
Device (устройство). Выберите устройство из списка. Список закроется, и изображение устройства 
появится в верхнем левом углу окна. Теперь устройство выбрано и готово к установке. 
 
Некоторые устройства имеют специальные функции, которые нужно настроить до установки 
устройства. Это можно сделать и позже, но может оказаться полезным настроить их при 
установке. В качестве примера, на приведенном рисунке показаны дополнительные настройки 
звукового сигнального устройства. Конкретные настройки каждого устройства описаны в 
соответствующем разделе этого руководства. 
 
Существует два способа установки устройства на шлейф. Один из них заключается в поочередной 
установке устройств. Второй метод позволяет установить несколько устройств одного типа на 
большом участке шлейфа. 
 

Установка одиночных устройств 
 
Для установки на шлейф одиночного устройства, выберите тип устройства, как описано выше, и 
щелкните на кнопке 'Place Device' (установить устройство). Кнопка станет красной, показывая, что 
устройство можно устанавливать на шлейф. 
 
Для размещения устройства, перейдите в сетку устройств и щелкните указателем в клетке адреса, 
куда хотите поместить устройство этого типа. В сетке устройств появится изображение устройства. 
Теперь установка устройства завершена. 
 

Установка нескольких устройств 
 
Иногда бывает удобно установить на шлейф несколько устройств одновременно, а не 
устанавливать их по одному. Для установки нескольких устройств, выберите устройство, которое 
хотите установить, используя описанный выше метод (с помощью выпадающего списка Device 
Control). Для выбора области, в которую хотите установить устройство, щелкните и удерживайте 
левую кнопку мыши над начальным адресом в сетке устройств. Перемещая мышь, выделите 
область, в которую хотите установить устройство. Область может быть только прямоугольником. 
Ниже показан выбор адресов от 101 до 108. Заметьте, что первый адрес не выделен красным 
цветом, а обведен рамкой. Этот адрес будет изменен так же, как и красные адреса. 
 
Для установки устройств в выделенную область, щелкните на кнопке 'Apply to Selection' (применить 
к выделенной области) в окне Device Control (управление устройством). 
 
Если в выделенной области уже есть некоторое устройство, то после нажатия кнопки 'Apply to 
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Selection' появится запрос, хотите ли вы установить новое устройство на место старого. Вы можете 
решить не устанавливать устройство, и в этом случае прежнее устройство останется на своем 
месте. Чтобы заменить устройство, щелкните на кнопке 'Yes' (да), чтобы оставить на месте 
прежнее устройство, щелкните на кнопке 'No' (нет). 
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Удаление устройств со шлейфа 

 
Для удаления устройства со шлейфа, щелкните правой кнопкой на устройстве, которое хотите 
удалить, в сетке устройств окна 'Loop Details' (сведения о шлейфе). Откроется всплывающее меню 
с опцией 'Delete device' (удалить устройство) и некоторыми другими опциями. Чтобы удалить 
устройство, щелкните на кнопке 'Delete Device'. Изображение устройства удалится из сетки, а само 
устройство удалится из базы данных точки. 
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Вставка/удаление мест 

 

Вставка пустого места 
 
Чтобы вставить пустое место в зону (и увеличить на единицу адрес у всех устройств, следующих 
за пустым местом), щелкните правой кнопкой на нужном адресе и выберите пункт 'Insert Device' 
(вставить устройство). 
 
 

 
Появится предупреждение с просьбой подтвердить вставку. 
 

 
 

Примечание: 
Если шлейф уже содержит 250 устройств, вставить пустое место нельзя 
 

Удаление пустого места 
 
Чтобы удалить пустое место из зоны (и уменьшить на единицу адрес у всех устройств, следующих 
за этими местом), щелкните правой кнопкой на этом месте и выберите 'Remove Location' (удалить 
место). 
 
 

 
 

Появится предупреждение с просьбой подтвердить удаление. 
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Перечень входных устройств DF6000 
 
Пожарная панель DF6000 поддерживает следующие устройства: 
 

• Оптические извещатели 
• Ионизационные извещатели 
• Тепловой извещатель A1R 
• Комбинированный оптический и тепловой извещатель 
• Тепловой извещатель BS 
• Тепловой извещатель CS 
• Датчик угарного газа 
• Ручной извещатель 
• Монитор зоны 
• Световой извещатель 
 
Для обозначения этих извещателей используются следующие символы: 
 

 
     
Оптический Ионизационный Тепловой 

A1R 
Оптический / 
Тепловой 

Тепловой BS 

 
     

Тепловой CS CO Ручной 
извещатель 

Монитор 
зоны 

Световой 
извещатель 

 
 
Извещатели имеют некоторые дополнительные параметры, кроме параметров программируемых 
входов. Эти параметры описаны ниже: 
 
Оптическое устройство 
 
Оптическое устройство имеет параметр Чувствительность. Для изменения чувствительности, 
щелкните правой кнопкой на устройстве, которое было установлено на шлейф. Откроется 
следующее меню: 

 
 
Щелкните левой кнопкой на опции 'Sensitivity Level' (уровень чувствительности). Откроется 
диалоговое окно: 
 
Щелкнув на выпадающем списке, откройте список доступных значений чувствительности. После 
выбора нужного уровня щелкните на 'OK', и новое значение вступит в силу. 
 
Ионизационное устройство 
 
Ионизационное устройство имеет параметр Чувствительность. Для изменения этого параметра 
следуйте инструкциям, приведенным в разделе 'Оптическое устройство'. 
 
Тепловые устройства A1R, BS и CS 
 
Тепловые устройства не имеют дополнительных параметров. 
 
Оптическое/тепловое устройство 
 
 
Оптическое/тепловое устройство имеет параметр Чувствительность. Для изменения этого 
параметра следуйте инструкциям, приведенным в разделе 'Оптическое устройство'. 
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Датчик угарного газа 
 
Датчик угарного газа не имеет дополнительных параметров. 
 
Ручной извещатель 
 
Ручной извещатель не имеет дополнительных параметров. 
 
Монитор зоны 
 
Монитор зоны не имеет дополнительных параметров. 
 
Световой извещатель 
 
Световой извещатель не имеет дополнительных параметров. 
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Программирование входных устройств 

 
Для программирования входного устройства в первую очередь надо открыть окно Device Inputs 
(входы устройств). Для этого щелкните правой кнопкой на устройстве в сетке устройств. Если 
это устройство имеет входы, откроется следующее контекстное меню: 
 
Выберите пункт 'Device Inputs' (входы устройств) и откроется следующее окно: 
 
Ниже перечислены опции, доступные для программирования входов, и дано описание 
выполняемых ими действий: 
 
Пожар 
Показывает, что было обнаружено возгорание 
 
Отказ 
Показывает, что в системе произошел отказ 
 
Сброс 
Заставляет станцию выполнить сброс устройства 
 
Отключение звуковой сигнализации 
Отключает все звуковые сигнальные устройства точки 
 
Предварительное оповещение 
Предупреждение о том, что условия, регистрируемые извещателем, приближаются, но еще не 
достигли уровня, при котором сработает сигнализация 
 
Эвакуация 
Активирует все звуковые сигнальные устройства и выходы точки 
 
Изоляция зон 
Переводит все перечисленные на станции зоны в режим отключения 
 
Изоляция адресов 
Переводит все адреса, перечисленные в одном шлейфе, в режим отключения 
 
Без защелкивания 
Событием без защелкивания называется такое событие, которое может происходить несколько 
раз, не требуя сброса системы. Например, при возникновении отказа без защелкивания, через 
несколько минут такой отказ может устраниться, а затем проявиться снова. Событие без 
защелкивания вызывает сброс станции, если в сети зарегистрирован один или два пожара 
 
Совпадение 
Устройство включает сигнализацию только в том случае, если пожар зарегистрирован двумя и 
более извещателями 
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Диапазон входных устройств DF6000 

 
Пожарная панель DF6000 поддерживает следующие устройства: 

• Звуковые сигнальные устройства. (Сюда относятся также световые извещатели и дистанционные 
индикаторы) 

•  Блок управления звуковыми сигнальными устройствами  

•  Голосовой извещатель 

•  Ретранслятор 

 
Для обозначения этих устройств используются следующие символы: 

    

Звуковое 
сигнальное 
устройство 

Управление 
звуковым 
сигнальным 
устройством 

Голосовой 
извещатель 

Ретранслятор 

 

Выходные устройства имеют некоторые дополнительные параметры, кроме параметров 
программируемых выходов. Эти параметры описаны ниже:  
 
Звуковое сигнальное устройство  

 

 
Звуковое сигнальное устройство имеет два параметра, тон и громкость  
 

 
Тон и громкость устройства настраиваются до начала установки устройства в сетку устройств. 
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Блок управления звуковыми сигнальными устройствами  

 

 
Блок управления звуковыми сигнальными устройствами не имеет дополнительных параметров. 
 
Голосовой извещатель  

 

 
Голосовой извещатель не имеет дополнительных параметров. 
 



 27

Программирование выходных устройств 

 
Для программирования выходного устройства в первую очередь надо открыть форму Device 
Outputs (выходы устройств). Для этого щелкните правой кнопкой на устройстве в сетке устройств. 
Если это устройство имеет выходы, откроется следующее контекстное меню: 
 
Выберите пункт 'Device Outputs'' (выходы устройств) и откроется следующее окно: 
 
Для каждого выходного канала можно запрограммировать до трех каскадов операций. Число 
каскадов выбирается из выпадающего списка в верхней части окна (см. рисунок сверху). 
 
Выходы можно программировать по Адресу, по Зоне и по Станции. Распределенные 
Адреса/Станции/Зоны можно выбрать, щелкнув на кнопке 'Allocate Devices' (распределение 
устройств) в правой части экрана. Другие опции устанавливаются с помощью флажков, в которых 
появляется галочка, если соответствующая опция включена. Показанное ниже окно 'Allocate 
Devices' использовано для распределения адресов устройств (запуск по адресу). 
 
Для звуковых сигнальных устройств и блоков ввода/вывода в окне Device Outputs (выходы 
устройств) появляется кнопка 'Apply these settings to other devices' (применить эти параметры к 
другим устройствам), нажатие на которую открывает следующее окно: 
 
Это окно позволяет применить текущее программирование выходов к выделенным устройствам 
или ко всем устройствам этого типа на станции. 
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Диапазон устройств ввода/вывода 

 
Пожарная панель DF6000 поддерживает следующие устройства: 
 

 •  Блок ввода/вывода 
 

Для обозначения этих устройств используются следующие символы: 
 
Устройство ввода/вывода 
 
Перед установкой устройства ввода/вывода в сетку, можно выбрать число входов и выходов в 
выпадающих списках окна Device Control (управление устройством): 
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Программирование устройств ввода/вывода 

 
Устройства ввода/вывода могут иметь несколько настраиваемых каналов ввода/вывода. Перед 
установкой устройства в сетку устройств нужно задать число каналов входа и число каналов 
выхода. Это делается с помощью выпадающих списков, которые появляются при выборе 
устройства ввода/вывода в окне 'Device Control' (управление устройством): 

 
После установки устройства, можно опросить входы/выходы, щелкнув правой кнопкой на 
устройства ввода/вывода. При этом открывается меню опций входов и выходов: 
 
Если опрашивается многоканальное устройство ввода/вывода, открывается окно, показывающее 
доступные для выбора каналы. При открытии окна в поле выбора входов/выходов отображается 
последний имеющийся выход, например, для устройства с 2 входами, в поле выбора будет 
отображаться цифра '2': 
 
После нажатия на кнопку 'OK', откроется соответствующее окно программирования 
входов/выходов. Программирование входов и выходов описано в предыдущих разделах: 
 
Программирование входов устройства 
 
Программирование выходов устройства 
 
Примечание: 
Если станция выполнила процедуру автоматического обучения, и данные переданы в компьютер в 
программу Установщика точки, все блоки ввода/вывода по умолчанию представляются как блоки с 
3 входами и 3 выходами. 
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Прочие устройства 

 
Пожарная панель DF6000 поддерживает следующие устройства: 
 
 • Блок управления доступом (ПОКА НЕДОСТУПЕН) 
 • Модуль аварийного освещения (ПОКА НЕДОСТУПЕН) 
 • Ретранслятор 
 
Для обозначения этих устройств используются следующие символы: 
 

     
Блок управления 
доступом 

Модуль аварийного 
освещения 

Ретранслятор 

 
 
Блок управления доступом 

 
 
Это устройство не имеет дополнительных параметров. 
 
 
Модуль аварийного освещения 

 
 
Это устройство не имеет дополнительных параметров. 
 

Ретранслятор 

 
 
 Блок управления ретранслятором не имеет дополнительных параметров. 
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Программирование выходов станции 

 
Выходы станции программируются из окна Panel Outputs (выходы станции). Чтобы открыть это 
окно, щелкните на показанной ниже кнопке 'Panel Outputs' (выходы станции). Эта кнопка 
появляется только в том случае, если выбраны Шлейфы/Станции/Зоны в дереве обзора. 
 
После нажатия кнопки откроется следующее окно: 
 
Станция имеет две цепи звуковых сигнальных устройств, противопожарное оборудование, 
устройство маршрутизации сигнала о возгорании, а также вспомогательное реле. Выбор опций 
осуществляется путем установки флажков. Щелкните на 'OK', чтобы подтвердить параметры или 
на 'Cancel' (отмена), чтобы оставить прежние параметры без изменения. 
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Ввод в эксплуатацию – передача данных на 
станцию 
 
Передача данных об устройствах и программирование со станции из программы "Установщик 
точки" позволяет ускорить программирование станции. 
 
Выберите станцию в дереве обзора и щелкните на кнопке 'Commission' (ввод в эксплуатацию) в 
секции Panel Details (информация о станции). Откроется следующая форма: 
 
Чтобы начать передачу для ввода в эксплуатацию, щелкните на кнопке 'Send Database to Panel' 
(передать базу данных на станцию). Появится предупреждение: 
 
На станции введите код доступа уровня 3, выберите в меню пункт Commission -> Load CDR from 
Laptop (ввод в эксплуатацию -> загрузка CDR из компьютера), а затем щелкните OK в окне 
сообщения программы Установщика точки. 
 
Панель должна принять данные и сброситься. Если прием данных закончился неудачно, 
проверьте следующее: 

• Убедитесь в наличии надежного соединения между компьютером и станцией и в том, что 
используется последовательный кабель нужного типа (перекрестный) 

• Убедитесь, что перед началом передачи файла из компьютера станция находится в режиме 
ввода в эксплуатацию 

• Убедитесь, что используется нужный коммуникационный порт. См. раздел Смена 
коммуникационного порта 

 

Ввод в эксплуатацию – прием данных со станции 

 
Эту функцию можно вызвать двумя способами: 

• Выберите точку в дереве обзора и щелкните на кнопке 'Retrieve Database from Panel' (получить 
базу данных со станции) (используется, если точка не содержит станций) 

• Выберите станцию в дереве обзора и щелкните на кнопке 'Commission' (ввод в эксплуатацию) 
 
Откроется следующее окно: 
 
После щелчка на кнопке 'Retrieve Database from Panel' (получить базу данных со станции) 
откроется следующее предупреждение: 
 
На станции введите код доступа уровня 3, выберите в меню пункт Commission -> Download CDR 
to Laptop (ввод в эксплуатацию -> загрузка CDR в компьютер), а затем щелкните OK в окне 
сообщения программы "Установщик точки". 
 
После этого база данных программы "Установщик" заполнится данными, взятыми со станции. Если 
прием данных закончился неудачно, проверьте следующее: 
  
• Убедитесь в наличии надежного соединения между компьютером и станцией и в том, что 

используется последовательный кабель нужного типа (перекрестный) 
• Убедитесь, что перед началом передачи файла в компьютер станция находится в режиме 

ввода в эксплуатацию 
• Убедитесь, что используется нужный коммуникационный порт. См. раздел Смена 

коммуникационного порта 
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